Using Excel in your economics assignments (& projects)

Objective of this handout

To assist your preparation for the an essay on a theme of Unemployment and inflation 

A significant marking criterion for this assignment is how well you can demonstrate your ability to use standard computer software (e.g. Microsoft’s Excel & Word). Since this is a learning outcome and an assessment ‘target’ I am obliged to ensure that you have either had tuition in using this software (e.g. arranged a workshop on the use of these computer programs) or, provided you with some instructions in these programmes (e.g. this handout). While this is my ‘remit’ and obligation the hope is that you should find these skills of data management and presentation relevant to your assignments at levels 2 & 3 (in particular your level 3 project/dissertation).

Purpose

a)
To introduce you to the use of Excel spreadsheets to plot and analyse time series data.

b) 
Demonstrate how diagrams can be created in Word using the drawing features found in this 
software. 

This handout has the following sections

1) 
Importing data from a Word table in to an Excel file.

2)
Plotting time series data using Excel’s chart wizard.

3)
Formatting a data plot (the Excel chart).

4)
Creating a duplicate data plot

5)
Transferring an Excel chart to a Word document

6)
From time series data create a scatter plot and fit a trend line (line of best fit)

7) 
Creating a diagram in Word using ‘Insert Object’ 

Importing data from a Word table in to an Excel file

The economic data that you could download from a web source is likely to be in one of three formats

(a)
It might already be in an Excel format (which is handy). 

(b)
In a table format in a word document 

(c)
In a PDF file

If the data is in a PDF format you will usually have to print the data out and then enter each observation by hand, If it is in a table format (b) then there is a quick way to copy & paste this data into Excel. This section explains how this is done using the April assignment as our example. The process is as follows:

1)
Log on & open Excel, save this blank workbook to your H drive (call it something like EP Essay data), 
then minimise Excel (we’ll return to this program shortly).

2)
Go to blackboard and down load – to your H drive, the EP Assessment Booklet, create a 
separate 
folder if you wish.

3)
Open up the Assessment booklet and scroll to page 34, using your mouse (cursor) click on the table 
labelled ‘Data for the essay task’. In the tool bar select ‘Table’ in the drop down menu choose 
‘Select’, and then choose ‘Table’ (all of the table will now be highlighted – in black & white).

4)
Go to the ‘Edit’ menu (in the tool bar) and in the drop down menu select ‘Copy’ 

5)
Restore/maximise Excel, select cell B3 (using your mouse) and in the ‘Edit’ menu select ‘Paste’, the 
result should look like this (Figure 1):
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Figure 1.

6)
While the data is still highlighted (in light blue) we can format the data to clear away the table 
formatting. First click on the border icon in tool bar (A above) and choose ‘No Border’. Then in the 
‘Format’ menu select ‘Cells…’ a pop-up menu will appear with various ‘tabs’ select ‘Alignment’ (see 
figure 2). In both the ‘Horizontal’ & ‘Vertical’ options select Center, in the ‘Text Control’ options ‘un tick’ 
Merge cells but tick Wrap text. In the ‘Font’ tab select font size 9, finish by clicking OK. 
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Figure 2

7)
You might now want to adjust the column widths to show all the column headings clearly. You do this 
by left clicking on the dividing line (B in figure 2)  between 2 columns (e.g. C & D and F & G) keeping the 
left mouse button depressed ‘widen’ your column by dragging the mouse to the right. Finally save your 
work and to reduce the clutter on you desk top, close the EP Assessment Booklet word document.

Plotting time series data using Excel’s chart wizard

The intention is to first plot both unemployment & inflation data for country A, format this graph and then create a copy which we will use for country B (i.e. we are cutting down on the formatting work by focusing on the one graph).

8) 
Using your mouse go to cell B4 (which should have the heading ‘Year’ in it). Left 
click on the mouse and 
move it across and down to highlight the unemployment & inflation data for all years (1 to 34) for country 
A only. 

9)
In the tool bar select ‘Insert’ and choose Chart. In the ‘Chart Wizard’ pop-up menu (shown below in 
figure 3) select XY (Scatter) and in the Chart Sub-type options click on the first option in the third row of 
options. (Contrary to your expectations the Line type plot is not particularly easy to format).  
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Figure 3

10)
Click ‘Next >’ twice to reach the ‘Chart Wizard – Step 3 of 4 – Chart options’ menu page (shown in figure 
4.) In ‘Chart title:’ type something like “Unemployment & inflation rates (%): Country A” in the Value (Y) 
axis:’ (the vertical one) type in a percentage sign % (as the data is expressed in percentages and not 
levels), click on finish and save your work! 
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Figure 4

Formatting a data plot (the Excel chart)

The results from steps 8 to 10 should look like figure 5. In figure 5 your chart has been inserted as an ‘object’ in sheet 1, as an ‘object’ in the worksheet the chart will be easier to format. In figure 5 you will note that along the borders and in the corners of the plot there are little black squares, which tell you the chart has been selected (clicked on) as a result the data that is being plotted is highlighted – the purple boundary denotes the year data, the green boundary surrounds the variable names and the blue boundary surrounds the actual observations. As you should appreciate the ‘plot’ as shown in figure 5 is pretty useless – frankly a bit of a mess all round. Quite why Microsoft chose this ‘look’ as their default option has always been a mystery to me, and means we have to format virtually all the elements in the plot.
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Figure 5

11)
First thing to do is to make the plot a little larger, you do this by left clicking on a corner (or 
border) of the chart and drag your mouse right to make the plot bigger (if this results in a plot that is too 
big or oddly sized, click on the undo icon in the tool bar (C) – or carry on re-sizing until you get the size you 
want.)  

12)
Click on the % label (value Y axis) and in the tool bar select ‘Format’ and choose
‘Selected Axis Title…’ 
The pop-up menu starts on a tab called ‘Alignment’, in the ‘Orientation’ option drag the red pointer to the 
horizontal position (see figure 6) and in the ‘Font’ tab select font size 10 – click OK.
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Figure 6

13) 
With the ‘%‘ value still highlighted (outlined) using your mouse (left click) drag it up to the top left hand 
corner to be just above the Y axis.
Then go to the chart title and change the font size from 15 to 10 (you 
do this by using the font size options in the tool bar (C – in figure 6). 

14)
Click on the legend titles (i.e. those that describe each line as either the rate of unemployment (%) or 
inflation (%)) and delete using the delete key. The plot area and its shape should change; it is the plot 
area we can now re-format.

15)
Double clicking on the grey plot area will see a ‘Format Plot Area’ pop-up menu appearing (Figure 7), in 
which tick ‘None’ in both Border & Area. 
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Figure 7

16)
The next thing to do is to format the axis, double click on the X axis (years) and in the pop-up menu 
select ‘Font’ tab & choose font size 10. Now select the ‘Scale’ tab (figure 8) and change the ‘Maximum’ 
value to 
34 (i.e. the total number of years in the sample), change also the ‘Major unit:’ value to 2 (this 
then shows every other year on this axis) – click OK. When you have done this you might find you that 
have to re-size the whole data plot to show the years (i.e. repeat step 11)
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Figure 8

17)
Now double click on the Y axis (%) and change the font size to 10, likewise change the ‘Maximum;’ 
value to say 11, and the ‘Major unit:’ value to 1.

18)
Now to format the grid lines, with your plot still highlighted (i.e. selected) go to the tool bar and select 
‘Chart’ in the drop down menu choose ‘Chart Options…’ and in the pop up showing tab labelled 
‘Gridlines’, tick Value (X) axis, Major Grid lines (as shown in figure 9) – click OK. 

19)
Staying with the grid lines double click on any one of the vertical grid lines to reveal the ‘Format 
Gridlines’ pop-up menu (figure 10).  The menu will automatically start at the pattern tab, click on ‘Color:’ 
and choose a pale grey colour – click OK and repeat this for the horizontal axis. 
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Figure 9
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Figure 10

20) 
We are now in a position to format the data series. Double click on either one to reveal the ‘Format 
Data 
Series’ pop-up menu. The default tab setting is again ‘Patterns’ - see figure 11 below.
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Figure 11


The purpose here is to format the data series – assuming that the data plot will be printed in black & 
white only and not in colour, we will need to distinguish between each series. We could use a dotted 
/dashed line (not recommended) or, use different markers (e.g. a filled circle and an unfilled/coloured 
circle. So for one series (e.g. unemployment):


i)
In the ‘Line’ options (circled) keep the ‘Style:’ as it is, in ‘Color:’ select black, in ‘Weight:’ choose 

the third option down (a heavier line but not the heaviest).


ii)
In the Marker options (also circled), in ‘Style:’ choose the circle option, In ‘Foreground:’ select 

black, in Background select white, In ‘Size:’ choose either 5 or 6. For this data series the marker 

will now appear to be a white coloured circle. Repeat the above steps for the other data series, 

but instead of a white background give it a black background – the result is this series’ marker 

is now a black coloured circle. Remember to save your work.

21)
Now we need to tell the reader which series is which and here you have a choice. You can re-instate the 
data series legends by selecting Chart / Chart Options… / Legend (tab) – tick ‘Show legend’ deciding 
where you want the legend placed (along the bottom is recommended) see figure 12. 
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Figure 12

22)
Or, (and this is a bit tricky and takes a bit of practice) place your mouse cursor on one single data marker 
and left click – this will highlight the whole series, but we only want this marker highlighted, so wait a 
second and left click again, this should reveal a yellow pop-up 
that describes this particular data point 
(see figure 13).  
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Figure 13


Now double click to reveal the ‘Format Data Point’ menu, select ‘Data labels’ and tick series name 
(circled in figure 14) - click OK. In your chart you will see the series name appear and this will need to be 
re-formatted (e.g. bold, font size 9). You can shorten its name by changing the entry in the relevant cell 
(e.g. cells C4 & D4 in figure 15)
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Figure 14
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Figure 15

Creating a duplicate data plot

Hopefully steps 8 to 22 should result in something similar to figure 15. Once you have fiddled around with the formatting of your chart for country A and have what you feel is the ‘best plot’ you will be ready to make duplicate data plot country B.

23)
First it is advisable to reduce the zoom from 100% to 75% (see (D) in figure 15); this reduces the size of 
everything on view and the gives you a bigger area to work in.

24)
Click on you diagram/plot for Country A and move it to one side of your data, and then go to the ‘Edit’ 
menu and select ‘Copy’ , move your cursor to just below the data plot and go to the ‘Edit’ menu and 
select ‘Paste’. A duplicate plot will appear but will need to be re-sized to be the same size as the original. 
If you’ve done this your screen should look something like the one shown below in figure 16. Notice that 
in this ‘screen save’ the bottom chart is highlighted (as indicated by the little black squares picking out 
the borders) & because it is highlighted the data series is also highlighted by the purple, green and blue 
boarders (see page 4).
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Figure 16

25)
To create your plot for country B simply click on the blue border (that which encompasses all the data 
observations) and drag it left to be in position over columns F & G at row 5 (i.e. in the same position but 
over 3 columns) The immediate result will look like that shown in figure 17. 

26)
From figure 17 you’ll see that the chart title will need to be changed (country A  to Country B)  - so here 
click on the chart and in the ‘Chart Options’ pop up menu (see figure 9 & 12) select titles and amend the 
current entry. Also you might want to change the data series names as you did in step 22 / figure 15.
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Figure 17


It is worth noting that the chart title, the axis names and the data series names can all be changed by 
clicking on the relevant title. In doing  this the title will be highlighted (shown by a boarder – see figure 
17a below), placing your cursor inside this ‘box’ you can use your arrow keys (left & right) to get to the 
letter(s) you want to change.  
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Figure 17a

Transferring your Data plots to a word document

In figure 18, I have re-formatted & resized my County B plot and when placed side by side we can see the only difference between the two is the data series and the chart titles. The intention now is to place these plots in the word document that will become your essay.
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Figure 18

27)
Open word and create a file called something like EP Essay, and save it to your H drive. Return to your 
Excel file and click on one of the diagrams and copy it (see step 24). 

28)
Go to your word document and in the edit menu select ‘Paste special…’ in the pop-up menu select 
‘Picture (Enhanced Metafile)’ – see below figure 19. The enhanced metafile uses less memory and 
makes it much easier to re-size the data plot, however if you notice a mistake in your plot (i.e. incorrect 
spelling) you will have to return to the excel file – make the correction there and then copy and paste 
the corrected data plot.
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Figure 19

Positioning your data plot in the word document

29)
Once you have pasted your plot in the word document, go to the View menu and 
in ‘Toolbars…’ select 
‘Drawing’ and a drawing tool bar will appear at the bottom of your screen – it will look like the one 
shown in figure 19 above. Click on your plot 
and then go to ‘Draw ▼’ (bottom left hand corner) and 
select ‘Text Wrapping…’ and choose ‘Tight…’ this will make it easier to move your data plot about, you 
should allocate at least 1/3rd of your page to this data plot and since it will be the sole focus of your 
essay do not consign it to an appendix!!!


An example of a typical data plot is shown in figure 20 note how the plot is labelled, note also that much data can be packed into a single diagram – perhaps here there is too much data – certainly three sets data series is about as much as the ‘eye’ can cope with.




Figure 20. UK  Unemployment, Inflation & Growth over the election cycle 1950 to 2003

From time series data create a scatter plot and fit a trend line (or ‘line of best fit’)

From the above plot of unemployment & inflation for the UK (from 1950 to 2003) these appears to be periods when unemployment & inflation move in the opposite direction (i.e. when unemployment is high, inflation is low). This is particularly apparent for the periods 1950 to 1966 and from the early 1980s to the early 1990s. 

We might therefore want to create a scatter plot to have a closer look at any likely relationships. A scatter plot is simply one variable (X) plotted against the other variable (Y), in the above example we would want to plot unemployment (along the X axis) against inflation (plotted on the Y axis)
.  

To create a scatter plot you will basically follow the steps you took to create the time series plots (i.e. steps 8 to 26). However since we want unemployment to be plotted along the X axis we have to make sure that it is in the first column of the two columns containing the unemployment and inflation data (fortunately this is the case anyway). So, as in step 8 highlight only the unemployment and inflation data (you should not highlight the year column). Use the chart wizard to include a title for the chart and axis and then format the following: 

· The alignment of the axis titles (steps 12 & 13)

· The plot area to have no border and no pattern (step15)

· The scale of each axis (steps 16 & 17)

· Remove any grid lines (see step 19) 

If you have done all the above for country B the result should look something like that in figure 21
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Figure 21

In the above screen save you will note that I have highlighted the chart (i.e. clicked on it) which the shows the two columns of data used in the scatter plot. You noticed also that the formula bar tells us which row and columns the data are to be found (have a look back at the formula bar in figures 11, 13 &14) .  For country B there does seem to be a close inverse relationship between unemployment and inflation (when one is high the other is low).

To get an idea of the extent of this relationship we can fit a line of best fit using Excel. So click on your chart and then go to the tool bar a select ‘Chart’, in the drop down menu select ‘Add Trendline…’ the pop-up menu for ‘Add Trendline’ is shown in figure 22. The default option is Linear (shown as the shaded choice in figure 22 – which will suit our purposes here). To get the coefficients for this line of best fit go to the ‘Options’ tab an tick: ‘Display equation on chart’ and tick ‘Display R-squared value on chart’  
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Figure 22

If you have followed these steps you should end up with your work area looking like that shown in figure 23. In my example I have formatted the equation and R-squared simply to highlight them for you benefit.
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Figure 23

For an example of how the equation and R-squared values can be interpreted see page 23 of the module handbook. Note that here the term -0.6575x is referring to the slope of the line and the term + 6.9178 is the intercept – i.e. where the line would strike the inflation axis (Y).

To do the same scatter plot for country A you will have to repeat all the above steps (unfortunately you can not use the country A data in a copy of the country B scatter plot). If you intend to use a scatter plot in your essay, then the procedure to copy and paste is the same as above (steps 27 to 29)

Notwithstanding, the above scatter plot (in figure 23) and the line of best fit is clearly telling us something about the relationship between unemployment and inflation in country B – which is what you will be expected to explain and illustrate in the April essay. To do this you will need to draw the models economics uses when tackling such a task, so the last section shows how you can go about creating your own diagram using the ‘Insert Object’ feature found in Microsoft Word. 
Creating a diagram of an economic model using ‘Insert Object’ in Word

The latest versions of Word have an irritating default option that when you select a line or an ‘AutoShape’ from the drawing tool bar, an automatic drawing canvas appears which says ‘Create your drawing here’, to disable this ‘automatic’ option (highly advised) go to the ‘Tools’ menu and select ‘Options…’ (which is at the bottom of the list). The pop-up menu has many tabs, but select only ‘General’ and un-tick the last item (as shown in figure 24 below).
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Figure 24

With this feature disabled you can now use ‘Insert object’ without this drawing canvas constantly popping up. 

1)
Go to the ‘Insert’ menu in the word tool bar and in the drop down menu select ‘Object…’ the pop-up 
menu will look like the one shown in figure 25 and you will have to scroll down and select ‘Microsoft 
Word Picture’
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Figure 25

2)
It is best to explain what is happening, essentially you have a document within a 
document and you are 
presently in the ‘inner document’ (imagine that the main word document is behind you and to get to it 
would mean having to turn around and leave by a magic door). The screen you are looking at, does not 
at first appear very easy to understand, however if you change the zoom from 100% to 50% and use 
your scroll bars to locate the drawing canvas in the middle of the picture you will get a better idea of 
what’s going on – see figure 26.  

3)
As it happens the canvas shown in figure 26 is too small so enlarge it by changing the ‘rulers’ to the left 
and at the top of the work area. To do this (rather like changing an excel column width) left click on the 
divide and drag your mouse up or down (left or right accordingly).

[image: image25.emf]   


Figure 26

4)
You will now want to change the font size to about 18 or 22 (yes you are making a very big diagram). 
Given that you will be drawing an economic model, you will want some labels for the axis so start by 
typing the vertical axis’ label (e.g. price deflator). Having done this use your tab key to work your way 
through the work area to get to the bottom right hand corner to the place where you want the other axis 
label type in the name (e.g. National Income). 


If all or part of what you have typed seems to have disappeared, then what has happened is you have 
‘slipped’ in to another drawing canvas (if you adjust your zoom to about 25% you’ll see there are two 
canvases – see figure 27) to correct this simply place your cursor at the beginning of the word or phrase 
you type and hit the backspace key until both axis labels appear in the one canvas (don’t forget to 
change the zoom back to about 80-100%!).  

5)
Having set out the basic area for your drawing/diagram use the drawing features to create the lines you 
want (the drawing tool bar appears automatically when using Word Picture - again it is along the bottom 
of your screen). As you draw in your lines remember to label them, likewise any points you are 
identifying on the axis and which you will be referring to in the main body of the text (e.g. Y & P1 below in 
figure 28). 


Note as you type in curve labels or axis points any text below or to the right of where you are typing 
might slip into another canvas so you’ll have to do some back-spacing (step 4), to get it back into the 
main drawing. 


Yes its all a bit fiddly, but the Word Picture result is far more stable than say one using a power point 
slide to create a drawing and is easier to re-adjust, Furthermore, it uses up less space than a drawing 
created in Paint or the like.
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Figure 27
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Figure 28

6)
When you have created your masterpiece, simply click on ‘Close Picture’ (circled in figure 28) to return to 
the main word document. This can also be done by going to the file menu where the drop down menu 
has an option to ‘close & return’ to the main document.

7)
Back in the main word document you will see your completed diagram and is likely to be just too big 
(taking up to 3/4 of the page), so here click on the picture and re-size it.  Here it is worth remembering 
that besides making it a bit easier to complete a drawing in an ‘oversized’ canvass (which is what you 
were creating in steps 3 & 4), when it comes to ‘re-sizing’ its better to go from big to small rather than 
small to big –  the latter tends to see your diagrams going ‘wonky’ and out of proportion.

This will do for now! Happy plotting and pasting
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� 	See page 14 of the module handbook for an example of a scatter plot using seminar attendance (X) 	against final mark (Y)
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